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1 Introduction

PhyloSketch App (also known as PhyloSketch2) is an application for interactively creat-
ing and editing phylogenetic trees and networks by drawing them. Written in Java using
JavaFX, this program runs on Mac OS, Linux, and Windows and is also designed for touch-
screen devices running iOS or Android.

PhyloSketch App is a new program based on PhyloSketch (also known as PhyloS-
ketch1), a previous program which was introduced in [Francis et al., 2021]. The program
uses some of the same code as our SplitsTree app [Huson and Bryant, 2024].
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2 Installation

• The macOS, Linux, and Windows versions are available from the GitHub page: https:
//github.com/husonlab/phylosketch2 or https://software-ab.cs.uni-tuebingen.
de/download/phylosketch2/welcome.html.

• The iOS app is available for testing via Apple TestFlight. If you are interested in beta
testing, contact the author for an invitation.

• Open the app and grant any necessary permissions for accessing storage, if prompted.

3 Getting Started

When you first open PhyloSketch, youll be presented with a canvas containing a simple
example tree. Modify the example or start creating your own phylogenetic tree or network.
The toolbar at the top provides access to all major functions, including mode selection,
import options, and various editing tools.

4 Modes Overview

PhyloSketch operates in four primary modes:

4.1 Edit Mode

• Create new nodes and edges by drawing directly on the canvas.

• Use this mode for building a new tree or network from scratch or for modifying one.

4.2 Transform Mode

• Move nodes, reshape edges, and adjust the layout of your phylogenetic tree or net-
work.

• Touch and drag nodes or edges to reposition them.

4.3 Read-Only Mode

• Editing is locked, but you can still select nodes or edges for viewing details.

• Useful for viewing a tree or network without accidental modifications.
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4.4 Capture Mode

• This mode is available after an image has been loaded.

• Use this mode to capture nodes, edges and labels present in the image.

5 Tool Bar Overview

The toolbar provides access to the core functionalities of PhyloSketch:

5.1 Mode Selection

Select the desired mode (Edit, Transform, or Read-Only) using the first item on the toolbar.

5.2 Import Button

• Paste a tree or network (Newick format) onto the canvas.

• Imported structures will be ready for editing or analysis.

5.3 Files Menu Button (Desktop version only)

Access file-related options, including creating, opening, and managing recent files. Not
available in the mobile app.

5.4 Selection Menu Button

Select nodes or edges based on their properties:

• All - Select all nodes and edges.

• None - Deselect all.

• Invert - Invert the selection.

• Roots/Leaves - Select root or leaf nodes.

• Articulation Nodes - Select nodes that separate biconnected components.

5.5 Topology and Layout Menu Button

Outlines Toggle the display of outlines around network elements.

Rotate Left Rotate the entire phylogenetic network counterclockwise by 90 degrees.
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Rotate Right Rotate the entire phylogenetic network clockwise by 90 degrees.

Flip Horizontal Reflect the phylogenetic network horizontally across its vertical axis.

Flip Vertical Reflect the phylogenetic network vertically across its horizontal axis.

Resize Mode Enable interactive resizing of the network while maintaining structure.

Layout Labels Adjust the positioning of node labels to improve readability and avoid
overlaps.

Rectangular Layout Arrange the phylogenetic network in a rectangular layout for better
visualization.

Circular Layout Rearrange the network into a circular configuration to emphasize rela-
tionships.

Merge Nodes Combine selected nodes into a single node, preserving connectivity.

Remove Thru Nodes Eliminate intermediate nodes that have in-degree one and out-
degree one, simplifying the network.

Reverse Edges Reverse the direction of selected edges while maintaining network in-
tegrity.

Fix Crossing Edges For any selected node of degree for, replaces the node by two
crossing edges.

Declare Root Designate a specific node as the root of the phylogenetic network, redi-
recting edges where necessary.

Declare Transfer Acceptor Declare a edge as the recipient of a horizontal gene transfer
event. There can be at most one such edge per reticulation node.

Induce Generate the subnetwork induced by a selected subset of nodes.

5.6 Formatting button

This toggles the appearance of the formatting panels described below.
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5.7 Capture Menu Button

When a background image has been loaded, use these items to capture a tree or network
from the image.

Press the menu button once to locate the root in the background image. Press again to
perform capture. Alternatively, use the following menu items.

Parameters... Open a dialog to configure various settings for network capture.

Load Image... Import an image to use as a background for the network.

Remove Image Remove the currently loaded background image from the view.

Place Root In preparation of network capture from the background image, locate the
root.

Capture Labels Use OCR to capture the labels in the background image.

Capture Lines Detect and capture lines from the image, potentially for network recon-
struction.

Capture Phylogeny Extract phylogenetic structures from the image, converting them into
a graph representation.

Here is an example of a captured network:

5.8 Other Toolbar Buttons

• Delete - Remove selected nodes/edges.

• Undo/Redo - Revert or repeat actions.

• Zoom In/Out - Adjust the view of the canvas.

• Export Menu - Copy selections or save images.
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6 Status Bar

Reports the number of components, roots, nodes, edges, leaves, and the hybridization
number h. Also indicates properties like ‘network‘ or ‘tree-based network‘.

7 Formatting Pane

The formatting pane has several panels for formatting nodes and their labels, and edges
and their labels.

7.1 Node Style Panel

This panel provides options for customizing the appearance of nodes. The following items
are available:

• Shape - A dropdown menu to select the shape of the node.

• Size - A combo box to specify or edit the size of the node.

• Color - A color picker to select the color of the node.

• Revert Button - A button to revert the node’s style settings (shape, size, and color) to
their default values.

7.2 Node Labels Panel

This panel provides options for labeling nodes. The following items are available:

• Nodes to Label - A dropdown menu to select which nodes should be labeled.

• Labeling Method - A dropdown menu to specify how the selected nodes should be
labeled.

• Unique Labels Toggle - A toggle button to enforce unique labels for nodes, preventing
reuse of existing labels.

• Label Input Field - A text field to manually enter labels for nodes.

• Note that you can use HTML-like tags for styling text (e.g., <i>, <b>, <sub>).
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7.3 Node Labels Formatting Panel

This panel provides options for formatting node labels. The following items are available:

• Font - A dropdown menu to select the font for node labels.

• Revert Font Button - A button to revert the font settings to default.

• Size - A combo box to specify or edit the font size for node labels.

• Revert Size Button - A button to revert the size settings to default.

• Bold Button - A button (B) to toggle bold formatting for node labels.

• Italic Button - A button (I) to toggle italic formatting for node labels.

• Underline Button - A button (U) to toggle underline formatting for node labels.

• Color - A color picker to set the text color of node labels.

• Revert Color Button - A button to revert the text color to default.

• Fill - A color picker to set the background fill color of node labels.

• Revert Revert Fill Button - A button to revert the background fill color to default.

7.4 Edge Style Panel

This panel provides options for customizing the appearance and properties of edges. The
following items are available:

• Shape - A set of buttons to select the shape of edges, including straight (S), rectan-
gular (R), curved (C), and smooth styles.

• Line - A dropdown menu to select the line style, such as solid, dashed, or dotted.

• Width - A combo box to specify or edit the line width.

• Color - A color picker to set the color of edges.

• Revert Color Button - A button to reset the edge color to its default value.

• Show Arrow Heads - A toggle button to enable or disable arrowheads on edges.

7.5 Edge Labels Panel

This panel provides options for managing edge labels, including weights, support values,
and probabilities. The following items are available:

• Weight - A text field to set the weight or branch length of an edge.

• Show Weight Toggle - A toggle button to display edge weights or branch lengths.

• Measure Weights Button - A button to set edge weights based on coordinates.
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• Support - A text field to set the confidence or support value, such as bootstrap values.

• Show Support Toggle - A toggle button to display confidence or support values.

• Probability - A text field to set probabilities for reticulate edges.

• Show Probability Toggle - A toggle button to display probabilities on reticulate edges.

7.6 Edge Label Style Panel

This panel provides options for customizing the style and appearance of edge labels. The
following items are available:

• Font - A dropdown menu to select the font for edge labels.

• Revert Font Button - A button to reset the font settings to default.

• Size - A combo box to specify or edit the font size for edge labels.

• Revert Size Button - A button to reset the size settings to default.

• Bold Button - A button (B) to toggle bold formatting for edge labels.

• Italic Button - A button (I) to toggle italic formatting for edge labels.

• Underline Button - A button (U) to toggle underline formatting for edge labels.

• Color - A color picker to set the text color of edge labels.

• Revert Color Button - A button to reset the text color to default.

• Fill - A color picker to set the background fill color of edge labels.

• Revert Fill Button - A button to reset the background fill color to default.

7.7 Edit Topology Panel

This panel provides options mainly for modifying the topology of the tree or network:

• Declare Root - Assign a specific node as the root of the phylogenetic network, redi-
recting edges where necessary.

• Resize Mode - Enable interactive resizing of the network while maintaining its struc-
ture and proportions.

• Merge Nodes - Combine multiple selected nodes into a single node while preserving
connectivity.

• Del. Thru Nodes - Delete nodes of indegree one and outdegree one.

• Reverse Edges - Invert the direction of selected edges while maintaining network
integrity.

• Cross Edges = For any selected node of degree four, replace the node with two
crossing edges.

• Declare Transfer Acceptor Edge - Declare an edge as the recipient of a horizontal
gene transfer event. There can be at most one such edge per reticulation node.
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8 Working with Nodes and Edges

8.1 Creating Nodes and Edges

• In Edit Mode, drag along the canvas to create edges.

• Double-click to create new nodes.

8.2 Transforming Nodes and Edges

• Drag nodes to move them.

• Adjust the shape of edges by dragging and reshaping.

9 Menus (Non-Mobile App Only)

9.1 File Menu

The usual file-related menu item:

• New. . . - Create a new document.

• Open. . . - Open an existing document (file suffix .psketch). Additionally, you can im-
port a tree or network from a file in Newick format (file suffix .new, .tre or similar) or a
file created by PhyloSketch1 (file suffix .nexus).

• Recent - Access a list of recently opened files.

• Load Background Image - Loads a background image for tracing over or phylogeny
capture.

• Export - Open the export submenu for saving data in different formats.

• Image. . . - Export the current canvas as an image file.

• Newick. . . - Export the current tree or network in Newick format.

• Save. . . - Save the current document.

• Page Setup. . . - Configure the page layout and settings for printing.

• Print. . . - Print the current document.

• Close - Close the currently open document or window.

• Quit - Exit the application.
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9.2 Edit Menu

The edit menu items are:

• Undo - Revert the last action.

• Redo - Repeat the last undone action.

• Cut - Remove the selected items and copy them to the clipboard.

• Copy - Copy the selected items to the clipboard.

• Copy Image - Copy an image of the current canvas to the clipboard.

• Paste - Insert the contents of the clipboard into the current document.

• Delete - Remove the selected nodes and/or edges.

• Clear - Delete all nodes and edges from the canvas.

• Remove Thru Nodes - Replace “thru nodes” (nodes with indegree 1 and outdegree
1) by direct edges.

• Declare Root - Change the root of the tree or network by selecting a new node or
edge.

• Declare Transfer Acceptor Edge - For any reticulate node, exactly one of the incoming
edges may be declared the transfer acceptor edge. If the selected edge is already
declared an acceptor edge, it loses this property.

• Mode - Switch between editing modes:

– Edit Mode - Enable adding and modifying nodes and edges.

– Move Mode - Allow repositioning of nodes and reshaping of edges.

• Find. . . - Search for a node or edge by label.

• Find Again - Repeat the previous search to locate the next matching node.

• Add LSA Edges - Add edges representing the Lowest Stable Ancestor (LSA) rela-
tionships between selected nodes.

9.3 Layout Menu

The Layout Menu provides items for customizing the layout and appearance of phylogenetic
trees and networks. The following items are available:

• Outlines - Toggles the display of the tree or network as an outline.

• Rotate Left - Rotates the tree or network 90 degrees to the left.

• Rotate Right - Rotates the tree or network 90 degrees to the right.

• Flip Horizontal - Flips the tree or network horizontally.
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• Flip Vertical - Flips the tree or network vertically.

• Resize Mode - Enables or disables resize mode, allowing nodes to be resized and
repositioned.

• Layout Labels - Resets the layout of node labels for better readability.

• Layout Rectangular Cladogram - Layout phylogeny as a rectangular cladogram

• Layout Rectangular Phylogram - Layout phylogeny as a rectangular phylogram

• Layout Circular Cladogram - Layout phylogeny as a circular cladogram

• Layout Circular Phylogram - Layout phylogeny as circular phylogram

9.4 View Menu

The View Menu provides items for adjusting the appearance, scaling, and layout of the
canvas. The following items are available:

• Use Dark Theme - Toggles between light and dark themes for the application inter-
face.

• Increase Font Size - Increases the font size of labels and text in the canvas.

• Decrease Font Size - Decreases the font size of labels and text in the canvas.

• Zoom In - Zooms into the canvas for a closer view.

• Zoom Out - Zooms out of the canvas for a broader view.

• Zoom To Fit - Adjusts the zoom level to fit the entire canvas within the window.

• Enter Full Screen - Switches the application to full-screen mode for an immersive
view.

9.5 Window menu

The Window menu items are:

• Set Window Size. . . - Allows the user to set the exact size of the window

• One item for each currently open document.

9.6 Help Menu

The Help menu contains the following items:

• Check for Updates. . . - Allows the user to check whether an update is available.

• About. . . - Shows an information window about the program.

• Help Window. . . - Shows a window containing this help document.
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10 Tips and Best Practices

• Start in Edit Mode to build structures.

• Use Transform Mode for refinements.

• Label nodes early for easier analysis.

11 Support and Feedback

For issues or suggestions, reach out via the GitHub repository or the apps support page.

12 Known Issues

• Status bar assumes all nodes/edges are in the same graph.

• iOS resizing issuesrotate device to fix layout problems.

• Imported layouts may require manual adjustments.

• Copy-paste between documents may not preserve formatting.
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